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reasons PDAs have not been quickly assimilated into the
restaurant and hospitality industries is that their small display sizes are not readily amenable to display of menus as
they are commonly printed on paper or displayed on, e.g.,
5 large, color desktop computer screens. Another reason is that
FIELD OF THE INVENTION
software for fully realizing the potential for wireless handThis invention relates to an information management and
held computing devices has not previously been available.
synchronous communications system and method for genSuch features would include fast and automatic synchronieration of computerized menus for restaurants and other
zation between a central database and multiple handheld
applications with specialized display and synchronous com- 10 devices, synchronization and communication between a
munications requirements related to, for example, the use of
World Wide Web ("Web") server and multiple handheld
equipment or software with non-PC-standard graphical
devices, a well-defined application program interface
formats, display sizes and/or applications for use in remote
(" API") that enables third parties such as point of sale
data entry, information management and synchronous com("POS") companies, affinity program companies and internet content providers to fully integrate with computerized
munication between host computer, digital input device or
remote pager via standard hardwired connection, the 15 hospitality applications, real-time communication over the
internet with direct connections or regular modem dialup
internet, a wireless link, smart phone or the like.
connections and support for batch processing that can be
done periodically throughout the day to keep multiple sites
BACKGROUND OF THE INVENTION
in synch with the central database. A single point of entry for
While computers have dramatically altered many aspects
20 all hospitality applications to communicate with one another
of modern life, pen and paper have prevailed in the hospiwirelessly has also previously been unavailable. Such a
tality industry, e.g., for restaurant ordering, reservations and
single point of entry would work to keep all wireless
wait-list management, because of their simplicity, ease of
handheld devices and linked Web sites in synch with the
training and operational speed. For example, ordering prebackoffice server (central database) so that the different
pared foods has historically been done verbally, either 25 components are in equilibrium at any given time and an
directly to a waiter or over the telephone, whereupon the
overall consistency is achieved. For example, a reservation
placed order is recorded on paper by the recipient or
made online would be automatically communicated to the
instantly filled.
backoffice server and then synchronized with all the wireless
handheld devices wirelessly. Similarly, changes made on
Although not previously adapted for wide-scale use in the
hospitality industry, various forms of digital wireless com- 30 any of the wireless handheld devices would be reflected
instantaneously on the backoffice server, Web pages and the
munication devices are in common use, e.g., digital wireless
other handheld devices.
messengers and pagers. Also in common use are portable
laptop and handheld devices. However, user-friendly inforFor the foregoing reasons, paper-based ordering, waitlist
mation management and communication capability not
and reservations management have persisted in the face of
requiring extensive computer expertise has not heretofore 35 widespread computerization in practically all areas of commerce. At most, computerization of these functions has been
been available for use in everyday life such as for restaurant
ordering, reservations and wait-list management. Hundreds
largely limited to fixed computer solutions, i.e., desktop or
of millions of dollars have been spent on personal digital
mainframe, because of the problems heretofore faced in
assistant ("PDA") development seeking to produce a small,
configuring wireless handheld devices and maintaining datalight-weight and inexpensive device that could be adapted to 40 base synchronization for such applications. Specifically, the
such uses; yet none have yielded a satisfactory solution.
unavailability of any simple technique for creating restaurant menus and the like for use in a limited display area
One of the inherent shortcomings of PDA type devices is
wireless handheld device or that is compatible with ordering
that, as they strive for small size, low weight and low cost,
over the internet has prevented widespread adoption of
they must compromise the size and clarity of the operator
display medium interface itself, which in most cases is one 45 computerization in the hospitality industry. Without a viable
solution for this problem, organizations have not made the
of a variety of LCD (liquid crystal display) type devices. As
efforts or investments to establish automated interfaces to
the size of the display shrinks, the amount of information
handheld and Web site menus and ordering options.
that may be displayed at anyone point or time is commenA principal object of the present invention is to provide an
surately decreased, typically requiring multiple screens and
displays to display information to the operator. This reduces 50 improved information management and synchronous communications system and method which facilitates userthe overall utility of the device. Additionally, the smaller
friendly and efficient generation of computerized menus for
display and keyboard results in a non-optimal operator
restaurants and other applications that utilize equipment
interface, which slows down operation and is thus unacceptwith non-PC-standard graphical formats, display sizes and/
able for the time criticality of ordering, reservation and
wait-list management and other similar applications. This 55 or applications.
necessitates many design compromises which in the aggreA further object of the present invention is to provide an
gate have resulted in limited acceptance of PDA type
improved information management and synchronous comdevices in the restaurant and hospitality fields.
munications system and method which provides for entry,
management and communication of information from the
Many of the negatives prevalent in earlier devices have
been eliminated, but, to date, there is still no integrated 60 operator as well as to and from another computer, Web page
menu, remote digital device using a standard hardwired
solution to the ordering/waitlistlreservation problem disconnection, the internet or a wireless link.
cussed above. With the advent of the Palm® and other
handheld wireless devices, however, the efforts to make such
A further object of the present invention is to provide an
improved information management and synchronous comdevices ubiquitous have begun to bear fruit at least in some
areas, e.g., personal calendars. However, substantial use of 65 munications system which is small, affordable and lightsuch devices in the restaurant and hospitality context has not
weight yet incorporates a user-friendly operator interface
occurred to date. As discussed above, at least one of the
and displays menus in a readily comprehensible format.
INFORMATION MANAGEMENT AND
SYNCHRONOUS COMMUNICATIONS
SYSTEM WITH MENU GENERATION
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A further object of the present invention is to provide a
synchronous information management and communications
system which enables automatic updating of both wireless
and internet menu systems when a new menu item is added,
modified or deleted from any element of the system.

4

direct connections or regular modem dialup connections and
support for batch processing that can be done periodically
throughout the day to keep multiple sites in synch with the
central database.
5
The communication module also provides a single point
of entry for all hospitality applications, e.g., reservations,
SUMMARY OF THE INVENTION
frequent customer ticketing, wait lists, etc. to communicate
with one another wirelessly and over the Web. This comThe foregoing and other objects of the present invention
munication module is a layer that sits on top of any comare provided by a synchronous information management and
communications system and method optimized for simplic- 10 munication protocol and acts as an interface between hospitality applications and the communication protocol and
ity of operation which incorporates menu generation for
can be easily updated to work with a new communication
creation of menus to be used with wireless remote handheld
protocol without modifying the core hospitality applications.
computer and PDA devices, the internet or any application
A single point of entry works to keep all wireless handheld
where simple and efficient generation of menus is appropriate. The menu generation approach of the present invention 15 devices and linked web sites in synch with the backoffice
server applications so that the different components are in
includes a desktop software application that enables the
equilibrium at any given time and an overall consistency is
rapid creation and building of a menu and provides a means
achieved. For example, a reservation made online can be
to instantly download the menu configuration onto, e.g., a
automatically communicated to the backoffice server and
handheld device or Web page and to seamlessly interface
with standard point of sale ("POS") systems to enable 20 then synchronized with all the wireless handheld devices
wirelessly. Similarly, changes made on any of the wireless
automatic database updates and communication exchanges
handheld devices are reflected instantaneously on the backwhen a change or input occurs in any of the other system
office server Web pages and the other handheld devices.
elements. To solve the above and other related problems, an
information management and communications system is
BRIEF DESCRIPTION OF THE DRAWINGS
provided which results in a dramatic reduction in the amount 25
of time, and hence cost, to generate and maintain computThe foregoing features and advantages of the present
erized menus for, e.g., restaurants and other related appliinvention can be appreciated more fully from the following
cations that utilize non-PC-standard graphical formats, disdescription, with references to the accompanying drawings
play sizes or applications.
30 in which:
The menu generation approach of the present invention
FIG. 1 is a schematic representation of a window dishas many advantages over previous approaches in solving
played on a computer display screen which shows a hierarthe problem of converting paper-based menus or Windows®
chical tree menu, modifier window and sub-modifier winPC-based menu screens to small PDA-sized displays and
dow in conformity with a preferred embodiment of the
Web pages. In one embodiment, the present invention is a 35 present invention.
software tool for building a menu, optimizing the process of
FIG. 2 is a schematic representation of a modifier dialog
how the menu can be downloaded to either a handheld
box in conformity with a preferred embodiment of the
device or Web page, and making manual or automatic
present invention.
modifications to the menu after initial creation.
FIG. 3 is a schematic representation of a menu category
The use of wireless handheld devices in the restaurant and 40 dialog box in conformity with a preferred embodiment of the
hospitality industry is becoming increasingly pervasive as
present invention.
restaurant owners and managers become more aware of the
FIG. 4 is a schematic representation of a menu item dialog
benefits. With the proper wireless handheld system in place,
box in conformity with a preferred embodiment of the
restaurants can experience increased table turns from
present invention.
improved server productivity and shorter order taking and 45
FIG. 5 is a schematic representation of a display customicheck paying times. Restaurants and POS companies seekzation
dialog box in conformity with a preferred embodiing to provide a wireless handheld interface to their desktopment of the present invention.
based POS systems or a Web page equivalent face several
FIG. 6 is a schematic representation of a communications
challenges. These challenges include building a menu using
their existing database and transferring the menu onto hand- 50 control window in conformity with a preferred embodiment
of the present invention.
held devices or Web pages that will interface with servers
wirelessly or to restaurants/customers over the internet. The
FIG. 7 is a schematic representation of a point of sale
menu generation approach of the present invention is the
interface on a wireless handheld device for use in displaying
first coherent solution available to accomplish these objecpage menus created in conformity with a preferred emboditives easily and allows one development effort to produce 55 ment of the present invention.
both the handheld and Web page formats, link them with the
DETAILED DESCRIPTION OF THE
existing POS systems, and thus provides a way to turn a
INVENTION
complicated, time-consuming task into a simple process.
The information management and synchronous commuMost personal computers today run under an operating
nications system of the present invention features include 60 system that provides a graphical user interface ("GUI") for
fast synchronization between a central database and multiple
accessing user applications. A GUI is used in the preferred
embodiment of the present invention. Through an interface
handheld devices, synchronization and communication
of windows, pull-down menus, and toolbars, GUI operating
between a Web server and multiple handheld devices, a
systems have simplified PCs and have rendered computer
well-defined API that enables third parties such as POS
companies, affinity program companies and internet content 65 technology more user friendly by eliminating the need to
memorize keyboard entry sequences. In addition, GUIs
providers to fully integrate with computerized hospitality
allow users to manipulate their data as they would physical
applications, real-time communication over the internet with
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entities. For example, a window can represent a file and the
cation programs to provide higher level functionality,
including a direct interface with the user. Specifically, the
contents of the window can represent the records of the file.
application programs make use of operating system funcThe window can be opened, closed, or set aside on a desktop
tions by issuing task commands to the operating system
as if it were an actual object. The records of the file can be
created, deleted, modified and arranged in a drag-and-drop 5 which then performs the requested task. For example, an
application program may request that the operating system
fashion as if they also were physical objects. The most
display certain information on a window for presentation to
common GUI operating systems that provide this "objectthe user.
oriented" environment for personal computers are Microsoft
An aspect of the preferred embodiment of the information
Windows® systems, including Windows CE® for handheld
management
and communications system of the invention is
wireless devices and the like. Generally, a particular appli- 10
shown in FIG. 1. FIG. 1 shows an example of the GUI
cation program presents information to a user through a
provided by the operating system of the preferred embodiwindow of a GUI by drawing images, graphics or text within
ment of the present invention. With reference to FIG. 1, the
the window region. The user, in turn, communicates with the
preferred embodiment includes an intuitive GUI 1 from
application by "pointing" at graphical objects in the window
which to build a menu on a desktop or other computer. A
with a pointer that is controlled by a hand-operated pointing 15 hierarchical tree structure 2 is used to show the different
device, such as a mouse, or by pressing keys on a keyboard.
relationships between the menu categories 3 (e.g., soups,
The use of menus is conventional in GUIs for software
salads, appetizers, entrees, deserts, etc.), menu items 4 (e.g.,
applications. Menus are typically utilized to provide end
green salad, chicken caesar salad, etc.), menu modifiers 5
users of applications with available choices or processing
(e.g., dressing, meat temperature, condiments, etc.) and
options while using the applications. For example, in a 20 menu sub-modifiers 6 (e.g., Italian, French, ranch, bleu
typical desktop or interactive application, selection of a
cheese, etc.).
"file" from a menu bar may cause display of a context menu
The procedure followed in configuring a menu on the
which provides "file" options. File options can have addidesktop PC and then downloading the menu configuration
tional subordinate or child options associated with them. If
onto the POS interface on the handheld device in conforma file option having subordinate options is selected, the child 25 ance with the preferred embodiment is as follows.
options are displayed in context in a child menu or submenu
The menu configuration application is launched by clickproximate to the selected parent option. One or more of the
ing on the appropriate icon on the desktop display screen.
child options provided in the child menu may have further
FIG. 1 will then be displayed. There are three windows on
subordinate options. Thus, such a menu system comprises
the screen shown in FIG. 1. The left window is the menu tree
cascading sets of menus which are displayable in context to 30 7, also called the tree view. The top right window is the
show the parent/child relationships between options of the
Modifiers window 8 and the bottom right window is the
context menu. A menu system of this type is incorporated
Sub-Modifiers window 9. The Sub-Modifiers window lists
into the preferred embodiment of the invention.
the sub-modifiers that correspond to the modifier that is
The preferred embodiment of the present invention uses
selected. The views on the right are referred to as list views.
typical hardware elements in the form of a computer
There are several ways of invoking a command, including
workstation, operating system and application software ele- 35 using the menu options; using the context menu (right
ments which configure the hardware elements for operation
mouse click); using the keyboard or using the toolbar icons.
in accordance with the present invention. A typical workFor example, if it is desired to add a category to the menu,
station platform includes hardware such as a central prothe following four options are available: (1) clicking on Edit,
cessing unit ("CPU"), e.g., a Pentium® microprocessor,
Add Category; (2) right mouse clicking on Menu, then
RAM, ROM, hard drive storage in which are stored various 40 clicking on Add Category; (3) highlighting Menu, then
system and application programs and data used within the
typing Ctrl+ T or (4) clicking on the Add Category icon on
workstation, modem, display screen, keyboard, mouse and
the toolbar. To add an item to a category, the following
optional removable storage devices such as floppy drive or
options are available: (1) highlighting the category to which
a CD ROM drive. The workstation hardware is configured
it is desired to add an item and then clicking on Edit>Add
by software including an operating system, e.g., Windows® 45 Item; (2) right mouse clicking on the desired category and
95, 98, NT or CE, networking software (including internet
then clicking on Add Item; (3) highlighting the desired
browsing software) and application software components.
category, then typing Ctrl+N or (4) clicking on the Add icon
The preferred embodiment also encompasses a typical file
on the toolbar.
server platform including hardware such as a CPU, e.g.,
When building a menu, it should be kept in mind that the
Pentium® microprocessor, RAM, ROM, hard drive, 50 menu items are stored using a tree metaphor similar to how
modem, and optional removable storage devices, e.g., floppy
files are stored on a PC with folders and sub folders. The
or CD ROM drive. The server hardware is configured by
menu structure is similar to the Windows® File Explorer in
software including an operating system, e.g., Windows® 95,
the way the items are organized hierarchically. Below is an
98, NT or CE, networking software (including Web server
example of how an item may be configured:
software) and database software.
55
A computer workstation for use in the preferred embodiment also includes a GUI. As is conventional, the GUI is
Menu
configured to present a graphical display on the display
Entrees
»
screen arranged to resemble a single desktop. Execution of
Red Meat
»
an application program involves one or more user interface
NYStrip
»
objects represented by windows and icons. Typically, there 60
Vegetables
»
may be several windows and icons simultaneously present
»
Tomato
»
Lettuce
on the desktop and displaying information that is generated
Meat Temperature
by different applications.
»
Medium Rare
The window environment is generally part of the operating system software that includes a collection of utility 65
In the above example, Menu is the root. Entrees is a menu
programs for controlling the operation of the computer
category. Red Meat is an Entree category. NY Strip is a
system. The computer system, in turn, interacts with appli-
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modifier. Vegetable is a modifier. Meat Temperature is a
To add menu items to categories, the menu category
modifier. Medium Rare is a sub-modifier of Meat Temperawhich is being built is clicked. For example, if items are
ture.
being added to Appetizers, the Appetizers branch is clicked
The steps taken in building a menu are as follows:
on. Then the Edit>Add Item is clicked on or Ctrl+N pressed.
1. Add Modifiers;
5 As before, if a menu is being built from scratch, the
2. Add Sub-Modifiers and link them to the Modifiers;
procedure is to enter the Long Name, Short Name, Code,
3. Create Menu categories;
Prep Time, Recipe and Price into the Menu Item dialog box
12 shown in FIG. 4. The Long Name is the full descriptive
4. Add menu items to the categories;
name of the item. The Short Name is the abbreviated name
5. Assign Modifiers to the menu items;
6. Preview the menu on the POS emulator on the desktop 10 that will be displayed on the handheld device. The Code is
the numeric or alphanumeric code for the item. Prep Time is
PC;
the time it takes to prepare the meal and Recipe would
7. Download the menu database to the handheld device.
include preparation methods and ingredients that are used in
To add modifiers, a user clicks on the inside of the
the preparation of the item. If there is an existing database,
Modifiers window, then (1) clicks on Edit>Add Modifier, (2)
Presses Ctrl+N; (3) right mouse clicks in the Modifiers 15 the existing database can be browsed and menu items
window, then clicks on Add Modifiers or (4) clicks on the
retrieved from the database. Clicking on the Browse button
Add icon from the toolbar. If a menu is being built from
will bring up the existing database of menu items. The item
to be added is then selected and OK is clicked. The fields
scratch, the procedure is to enter the Long Name, Short
Name, Code and Price in the Modifier dialog box 10 shown
will then be filled with the information from the database.
in FIG. 2. The Long Name is the full descriptive name of the 20 Clicking on OK again will add the item to the category.
item. The Short Name is the abbreviated name that will be
Once the menu items have been entered, it may be desired
to assign some modifiers to the menu items. For example, it
displayed on the handheld device. The Code is the numeric
may be desired to assign meat temperature to a steak order.
or alphanumeric code for the item. If there is an existing
To accomplish this, first the modifier to be assigned is
database, the existing database can be browsed and menu
items retrieved from the database. Clicking on the Browse 25 selected, then the menu item on the tree view that is to be
assigned the modifier is clicked on and then Edit>Assign
button will bring up the existing database of menu items.
The item to be added is then selected and "OK" is clicked.
Modifier is clicked on. Or, the modifier can simply be
The fields will then be filled with the information from the
dragged and dropped onto the menu item to link them. A
database. Clicking on OK again will add the item as a
dialog box is then displayed asking if this modifier is a
modifier. To delete a modifier, the modifier is selected and 30 required modifier. If it is a required modifier, the display
the Delete key pressed on the keyboard. To edit a modifier,
icon will be red but if it is a non-required modifier the
either the modifier is double clicked or the Enter key is
display icon will be green. As many modifiers as are
applicable can be assigned. If any changes are made to the
pressed.
modifiers, those changes will be automatically reflected
Sub-modifiers represent the last level of modifiers that can
be assigned to a menu tree. To add sub-modifiers, the 35 throughout the menu tree.
Once the modifiers have been entered, it may be desired
modifier to which sub-modifiers are to be assigned is
selected. Then, the focus is set on the sub-modifier window
to assign sub-modifiers to the modifiers items. For example,
by clicking inside the Sub-Modifier window as follows: (1)
it may be desired to add Honey Mustard as a sub-modifier
to Dressing. To accomplish this, first the modifier to be
clicking on Edit>Add Sub-Modifier; (2) pressing Ctrl+N; (3)
right mouse clicking in the Sub-Modifiers window, then 40 assigned a sub-modifier is selected, then the sub-modifier
clicking on Add Sub-Modifiers or (4) clicking on the Add
window is clicked on, then Edit>Add Sub Modifier is
icon from the toolbar. If a menu is being built from scratch,
clicked on, Ctrl+N entered or the Add icon from the toolbar
the procedure is to enter the Long Name, Short Name, Code
is clicked on. Or, the sub-modifier can simply be dragged
and Price in a Sub-Modifier dialog box similar to the
and dropped onto the modifier to link them.
Modifier dialog box shown in FIG. 2. As with modifiers, the 45
When the menu has been completely configured, it can be
Long Name is the full descriptive name of the item. The
previewed on a POS emulator on the desktop to verify that
Short Name is the abbreviated name that will be displayed
the menu is correctly configured before downloading it to
on the handheld device. The Code is the numeric or alphathe handheld device. To preview, File>Preview Database is
numeric code for the item. As before, if there is an existing
clicked on or the Preview Database icon from the toolbar is
database, the existing database can be browsed and menu 50 clicked on. The handheld POS emulator on the desktop can
then be run. If the configuration is deemed acceptable, the
items retrieved from the database. Clicking on the Browse
handheld device is connected to the desktop PC to ensure
button will bring up the existing database of menu items.
The item to be added is then selected and OK clicked. The
that a connection has been established; the POS application
fields will then be filled with the information from the
on the handheld device is exited and File>Download Datadatabase. Clicking on OK again will add the item as a 55 base is clicked on or the Download Database icon from the
sub-modifier. To delete a sub-modifier, the sub-modifier is
toolbar is clicked on. If there is an existing menu database
selected and the Delete key depressed on the keyboard. To
on the handheld device, the system will ask if the existing
edit a sub-modifier, either the sub-modifier is double clicked
database should be replaced. Yes is clicked if existing
database replacement is desired.
or the Enter key is pressed.
A database function enables the creation of, e.g., a breakMenu categories are created from the root. Some 60
examples of categories are Appetizers, Soups, Salads,
fast menu, lunch menu and dinner menu and downloading
them to a handheld device. Functions available are (1)
Entrees, Desserts, etc. The first step is to click on Menu in
the menu tree window. Categories are added by (1) clicking
creating a new database; (2) opening an existing database;
on the Add Category icon from the toolbar; (2) clicking on
(3) saving a database under a different name. To access these
Edit>Add Category or (3) pressing Ctrl+ T. As shown in FIG. 65 functions, File is clicked on the menu bar.
3, Menu Category dialog box 11 then appears in which to
The preferred embodiment encompasses customized
enter the Long and Short names for the menu category.
layout, views and fonts. To set the focus on the view it is
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desired to change, click inside the desired window. The main
customizing dialog box is accessed by clicking on
View>Customize View. A dialog box 13, as shown in FIG.
5, will be displayed including tabs that allow the following
options: selection of Columns to display in the list view by
choosing and arranging the fields to display in the Modifiers
and Sub-Modifiers windows; formatting Columns by specifying the column widths and justification; selecting Filter
allows restricting the list to display only the items that meet
certain criteria For example, display of modifiers with codes
between 500 and 550. Selecting Sort allows sorting the
modifiers or sub-modifiers according to any of the available
fields such as Name, Code or Price. Selecting Style facilitates choice of font type, style, size, etc. To change the font
in a particular window, click on View>Fonts or right mouse
click in the desired window and then click on Fonts. To
change the size of the windows, drag the borders of the
windows to expand or contract the size of the windows. To
change the column widths, simply drag the edge of the
column headers to increase or decrease the column widths.
A communications control program monitors and routes
all communications to the appropriate devices. It continuously monitors the wireless network access point and all
other devices connected to the network such as pagers,
remote devices, internet Web links and POS software. Any
message received is decoded by the software, and then
routed to the appropriate device. No user action is needed
during operation of the software once the application has
been launched. To launch the communications control
module, a Wireless Traffic icon is clicked on the desktop Pc.
When the program loads, the screen shown in FIG. 6
appears. Messages received are logged in the window 14
shown in FIG. 6 with a time stamp. The messages are also
logged to a file on the hard drive. This provides a mechanism
to monitor all traffic across the network (possibly useful for
troubleshooting, or maintenance, but not necessary for normal operation). The program may be minimized so the
screen is not displayed on the desktop, but it must be running
for proper communications to exist between all devices on
the network.
As stated, the preferred embodiment of the present invention includes the use of and compatibility with GUI technology. Adrag-and-drop approach is used for organizing the
tree structure 2 in the generated menu. Drag-and-drop is also
used for assigning modifiers (modifiers can be dragged from
the modifiers window 5 and dropped onto the menu item 4
for assignment). In-cell editing results in fast editing of
items in building the menus. Customizable fonts enable
users to change font types, style and size. Customizable
layouts enable users to resize windows, change icons and
display preferences. The inventive approach provides for
fully persistent storage between sessions, even if a session is
improperly or abruptly terminated. Font and the tree state
(i.e., which nodes are expanded/collapsed) are stored
between sessions. Layout for modifiers and sub-modifiers
list views (filter, columns, formatting, font, etc.) are stored
between sessions. The last database used is likewise stored
between sessions. Splitter views allow the user to see
different views at the same time. Each view is displayed on
its own section of the screen. Views can be resized via the
keyboard or a mouse by simply dragging the splitter in the
middle.
An automated function is provided to import existing POS
databases into the inventive menu generation system and, as
discussed above with respect to the detailed example of how
to use the preferred embodiment, an automated download
procedure is provided to transfer the desktop database onto

a handheld device and/or Web page. Also as discussed, the
preferred embodiment facilitates preview of the handheld
device or Web page version of the POS menu on the desktop
before downloading and configuration. Customizable desktop menu generation is contemplated, as discussed above, in
the form of customizable fonts, columns, layouts, etc. The
inventive approach also includes templates for common
modifiers that can be assigned to similar menu items. The
preferred embodiment also supports multiple databases, thus
providing for the creation and storing of different menu
databases on handheld devices such as breakfast, lunch or
dinner menus. The user can then select the appropriate
database to reflect the time of day.
FIG. 7 is a schematic representation of a point of sale
interface 15 for use in displaying a page-type menu 16
created using the inventive menu generation approach. As
can be seen from FIG. 7, the page menu is displayed in a
catalogue-like point-and-click format whereas the master
menu, FIG. 1, is displayed as a hierarchical tree structure.
Thus, a person with little expertise can "page through" to
complete a transaction with the POS interface and avoid
having to review the entire menu of FIG. 1 to place an order.
A PDA or Web page format could appear like FIG. 7 or the
display could be configured for particular requirements since
fully customizable menu generation and display are contemplated.
The POS interface on the handheld device supports pricing in the database or querying prices from the POS server.
The POS device also can be customized with respect to
"look and feel" for the particular version. As can be seen in
FIG. 7, the POS interface provides for billing, status and
payment with respect to orders. A myriad of options can be
provided depending on the application.
Advanced database functions are provided in the preferred embodiment of the invention, including an automated
download process onto handheld devices and/or Web sites.
In the preferred embodiment, the menu generation system of
the present invention uses an API called ActiveX Data
Objects ("ADO") for database access. ADO is useful in a
variety of settings. It is built on top of OLE DB and can be
used to talk to databases and, in the future, any data source
with any OLE DB driver. Advanced querying is supported.
The database can be queried on virtually all fields. Queries
can be built using SQL syntax for experienced users or can
be created using a query builder which guides users through
the creating process. Advanced error handling is supported.
Errors occurring at run time can be trapped. A descriptive
message is displayed to alert the user and provide error
information. However, the application does not terminate
when the errors happen. The source code is easy to maintain
and modify, thus allowing for on time delivery of customized versions of the software. The advanced database functions produce well-designed databases that accommodate
growth and scalability.
The inventive menu generation approach provides a solution for the pervasive connectivity and computerization
needs of the restaurant and related markets. The inventive
solution includes automatic database management and
synchronization, PDA and handheld wireless operating system integration and optimization, wireless communications
and internet connectivity, user interface design, and graphics
design.
In the preferred embodiment, the menu generation
approach of the present invention uses Windows CE® as the
operating system for the handheld devices. Windows CE®
provides the benefits of a familiar Windows 95/98/NT®
look and feel, built-in synchronization between handheld
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devices, internet and desktop infrastructure, compatibility
A further aspect of the invention is the use of the menus
with Microsoft Exchange®, Microsoft Office 9® and TCPI
generated in accordance with the described technique to
IP quick access to information with instant-on feature.
place orders from wireless remote handheld devices or from
Windows CE® provides a basic set of database and
remote locations through the internet. The World Wide Web
communication tools for developer use. However, interfac- 5 is a distributed hypermedia computer system that uses the
ing with these tools to provide application specific results
internet to facilitate global hypermedia communication
can be a complex task. In addition to the menu generation
using specified protocols. One such protocol is the Hyperdescribed above, a set of software libraries described herein
text Transfer Protocol ("HTTP"), which facilitates communication of hypertext. Hypertext is the combination of inforin conformance with the present invention not only enhances
the basic Windows CE® functionality by adding new fea- 10 mation and links to other information. In the context of the
Web, hypertext is defined by the Hypertext Mark-up Lantures but also maximizes the full potential of wireless
guage ("HTML"). The links or hyperlinks in a HTML
handheld computing devices. Such features include fast
synchronization between a central database and multiple
document reference the locations of resources on the Web,
handheld devices, synchronization and communication
such as other HTML documents. Another language used in
between a Web server and multiple handheld devices, a 15 creating documents for use on the Worldwide Web, to
well-defined API that enables third parties such as POS
display on computer screens, or to create speech style sheets
companies, affinity program companies and internet content
for use in, e.g., telephones, is the Extensible Mark-Up
providers to fully integrate with computerized hospitality
Language ("XML"). XML is a "metalanguage", i.e., a
language for describing languages which was developed to
applications, real-time communication over the internet with
direct connections or regular modem dialup connections and 20 eliminate the restrictions of HTML.
The Web is a client-server system. The HTML documents
support for batch processing that can be done periodically
throughout the day to keep multiple sites in synch with the
are stored on Web server computers, typically in a hierarcentral database.
chical fashion with the root document being referred to as
the home page. The client specifies a HTML document or
The synchronous communications control module discussed above provides a single point of entry for all hospi- 25 other source on the server by transmitting a Uniform
tality applications to communicate with one another wireResource Locator ("URL") which specifies the protocol to
lessly or over the Web. This communications module is a
use, e.g., HTTP, the path to the server directory in which the
layer that sits on top of any communication protocol and acts
resource is located, and filename of the resource. Users
as an interface between hospitality applications and the
retrieve the documents via client computers. The software
communication protocol. This layer can be easily updated to 30 running on the user's client computer that enables the user
to view HTML documents on the computer's video monitor
work with a new communication protocol without having to
modify the core hospitality applications. The single point of
and enter selections using the computer's keyboard and
entry works to keep all wireless handheld devices and linked
mouse is known as a browser. The browser typically
Web sites in synch with the backoffice server (central
includes a window in which the user may type a URL. A user
database) so that the different components are in equilibrium 35 may cause a URL to be transmitted by typing it in the
designated window on the browser or by maneuvering the
at any given time and an overall consistency is achieved. For
cursor to a position on the displayed document that correexample, a reservation made online is automatically comsponds to a hyperlink to a resource and actuating the mouse
municated to the backoffice server which then synchronizes
button. The latter method is commonly referred to simply as
with all the wireless handheld devices wirelessly. Similarly,
changes made on any of the wireless handheld devices will 40 "clicking on the hot-spot" or "clicking on the hyperlink".
be reflected instantaneously on the backoffice server and the
The hyperlink methodology is contemplated for use in
other handheld devices.
accordance with the preferred embodiment to transmit
The software applications for performing the functions
orders via the internet. Web server application software
falling within the described invention can be written in any
exists that enables a user to shop for and order merchandise.
commonly used computer language. The discrete program- 45 Such systems are sometimes referred to as electronic merming steps are commonly known and thus programming
chandising systems or virtual storefronts. Systems that
details are not necessary to a full description of the invenenable a user to choose among several retailers' goods are
sometimes referred to as electronic malls. An electronic
tion.
retailer's or electronic mall operator's Web server provides
A simple point-to-point wireless capability is contemplated which permits simple digital messages to be sent from 50 HTML forms that include images and descriptions of merthe wireless handheld devices to a receiver in a beeper
chandise. The user may conventionally search for an item by
andlor valet parking base-station. The POS interface of FIG.
entering a key word search query in a box on a form. When
7 is representative of the display on a typical wireless device
a user selects an item, the server may provide a linked form
used in conformity with the invention. A simple protocol is
that describes that item in further detail. The user may also
used to acknowledge receipt of the message and thus simul- 55 conventionally enter ordering information into boxes on the
form, such as the type and quantity of the item desired. The
taneous communication is not necessary, which reduces the
cost of the wireless link. The range of the wireless link is
information entered by the user is transmitted to the server.
determined by the characteristics of the radio transceiver.
The user may select multiple items in this manner and then
enter a credit card number to pay for the purchases. The
Adding a wireless link allows paging of beeper equipped
customers directly from the operator interface on the wire- 60 retailer processes the transaction and ships the order to the
customer. As can be appreciated, ordering merchandise can
less handheld devices and communication to and from
various input/output transmitters and receivers to update the
also be done from menus. The generation of menus of items
status of the order, reservation or other information and thus
or merchandise for sale over the internet is readily accomplished by the menu generation approach of the present
further reduce the workload on the operator and enable
operations to proceed much faster. This link could also be 65 invention.
Searching for items that the user is interested in purchashardwired or otherwise implemented using any two-way
ing is insufficient in prior merchandising systems. Database
messaging transport.
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"chicken", or "vegetarian". In this embodiment, only items
management programs use index searching to facilitate rapid
from the master menu that satisfy specified parameters will
searching of large amounts of data. The creator of the
be included in the generated menu. The selection process
database may instruct the program to use specified fields in
the database as indexed or key fields. The program locates
could involve selection of master menu items based on tags
all terms in the database that appear in the indexed fields and 5 or identifiers associated with the items or by checking every
master menu item against a dictionary of items acceptable
stores them in an index table. Each entry in the index table
for inclusion in the modified menu. It should also be
includes a term and corresponding pointer to the location in
the database where the term is found. If a user initiates a
appreciated that the invention encompasses any combination
of automatic and manual user selection of the items comsearch for a term that is present in the index table, the
program can locate the instances of that term in the database 10 prising the generated menu. For example, a user might
with exceptional speed. Users who are familiar with the
specify criteria which would further control automatic selecparticular database they are searching will generally know
tion or the user could manually select some items with
which fields are indexed and will know the format of the
automatic selection of others. The menu generation aspect of
the invention is equally applicable to table-based, drive-thru,
data in those fields. For example, a user of a database
containing the inventory of a bookstore may know that users 15 internet, telephone, wireless or other modes of customer
can search for the names of authors of books and that a user
order entry, as is the synchronous communications aspect of
who wishes to do so should enter the author's last name first.
the invention.
A user having such knowledge will therefore be able to
The inventive concept encompasses the generation of a
search efficiently. Users of electronic merchandising
menu in any context known to those skilled in the art where
systems, however, are generally end-consumers who have 20 an objective is to facilitate display of the menu so as to
no knowledge of a merchant's database. If, as is very likely,
enable selection of items from that menu. The restaurant
such a user initiates a search for a term that is not present in
menu generation embodiment is but one example of a use for
the index table, the program must sequentially search
the inventive concept. Likewise, displaying menus generthrough all records in the database. Sequential records are
ated in accordance with the invention on PDAs and Web
typically linked by pointers. Using pointers in this manner is 25 pages to facilitate remote ordering are but a few examples of
very demanding on server resources, resulting not only in an
ways in which such a menu might be used in practice. Any
exceptionally slow search, but also creating a bottleneck for
display and transmission means known to those skilled in
the art is equally usable with respect to menus generated in
other processes that the server may be executing. The menu
accordance with the claimed invention.
generation approach of the present invention can be used to
create customized menus from a database that includes 30
In the more general situation, menus can be generated in
every item of merchandise the vendor has for sale. In this
accordance with the present invention in a variety of situmanner, customers can scan the generated menu much more
ations. For example, the usable file structure for a particular
readily than they could view the entire database and the
data processing application can be dictated by the user or an
application program prior to or during the execution of the
necessity of having familiarity with the database is eliminated as well, reducing the need for resource intensive 35 application program. Efficiencies with respect to computapointers.
tional speed and equipment, e.g., storage and processor,
While the preferred embodiment of the invention is for
usage can thus be achieved along with the facilitation of
display of the generated menu.
the generation of restaurant menus and the like, the broad
scope of the invention is far greater. For example, menus
While the best mode for carrying out the preferred
generated in accordance with the invention can be used in 40 embodiment of the invention has been illustrated and
described in detail, those familiar with the art to which the
the desktop computing environment in association with the
invention relates will recognize various alternative designs
operating system or application programs. One such use is
to facilitate the creation of user personalized file structures
and embodiments which fall within the spirit of practicing
for general desktop use. Another use is to facilitate the
the invention. The appended claims are intended to cover all
location of customized menus from master menus for use in 45 those changes and modifications falling within the true spirit
association with application software to make the execution
and scope of the present invention.
of the application software more efficient by, e.g., eliminatThat which is claimed is:
ing the necessity of querying or checking every tree branch
1. An information management and synchronous commuin the master menu file structure in response to user input or
nications system for generating and transmitting menus
other criteria and to create handheldlPDA compatible ver- 50 comprising:
sions of the software.
a. a central processing unit,
While the preferred embodiment of the invention includes
b. a data storage device connected to said central prothe selection of items from a master menu wherein the
cessing unit,
master menu is displayed using a graphical user interface, it
c. an operating system including a graphical user
is to be appreciated that any means for displaying the master 55
interface,
menu to the user and generating another menu in response
d.
a first menu consisting of menu categories, said menu
to and comprised of the selections made is encompassed by
categories consisting of menu items, said first menu
the contemplated invention. The invention encompasses the
stored on said data storage device and displayable in a
selection of nontextual symbols, characters, icons and the
window of said graphical user interface in a hierarchilike, in addition to text, from a hierarchical tree menu or the 60
cal tree format,
like for generation of another menu comprised of such items.
e. a modifier menu stored on said data storage device and
It is also within the scope of the invention to generate
displayable in a window of said graphical user
menus automatically in response to predetermined criteria.
interface,
For example, in the restaurant menu generation
embodiment, a modified menu can be generated to comply 65
f. a sub-modifier menu stored on said data storage device
with a particular specification or group of criteria such as,
and displayable in a window of said graphical user
e.g., "dinner", "low cholesterol", "low fat", "fish",
interface, and
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g. application software for generating a second menu
from said first menu and transmitting said second menu
to a wireless handheld computing device or Web page,
wherein the application software facilitates the generation of
the second menu by allowing selection of catagories and
items from the first menu, addition of menu categories to the
second menu, addition of menu items to the second menu
and assignment of parameters to items in the second menu
using the graphical user interface of said operating system,
said parameters being selected from the modifier and submodifier menus.
2. An information management and synchronous communications system in accordance with claim 1, wherein the
second menu is a restaurant menu.
3. An information management and synchronous communications system in accordance with claim 1, wherein the
second menu is capable of being displayed on the display
screen of a wireless computing device.
4. An information management and synchronous communications system in accordance with claim 3, wherein selections from the second menu are capable of being transmitted
to a receiving computer by wireless link.
5. An information management and synchronous communications system in accordance with claim 3, wherein selections from the second menu are capable of being transmitted
to a receiving computer via the internet.
6. An information management and synchronous communications system in accordance with claim 1, wherein the
second menu is capable of being displayed on display
screens of computers in a network.
7. An information management and synchronous communications system in accordance with claim 6, wherein the
computer network is the internet.
8. An information management and synchronous communications system in accordance with claim 1, wherein the
second menu is created in conformity with hypertext markup
language or extensible markup language.
9. An information management and synchronous communications system in accordance with claim 1, wherein the
second menu overwrites the first menu.
10. The information management and synchronous communications system of claim 1, wherein the first menu and
the second menu are both capable of being displayed in the
same window on the display screen.
11. The information management and synchronous communications system of claim 1, wherein the menu categories
and items comprising the second menu are subsets,
respectively, of the menu categories and items comprising
the first menu.

12. An information management and synchronous communications system for use with wireless handheld computing devices and the internet comprising:
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a. a central database containing hospitality applications
and data,
b. at least one wireless handheld computing device on
which hospitality applications and data are stored,
c. at least one Web server on which hospitality applications and data are stored,
d. at least one Web page on which hospitality applications
and data are stored,
e. an application program interface, and
f. a communications control module,
wherein applications and data are synchronized between the
central data base, at least one wireless handheld computing
device, at least one Web server and at least one Web page;
wherein the application program interface enables intergration of outside applications with the hospitality applications
and wherein the communications control module is an
interface between the hospitality applications and any other
communications protocol.
13. The information management and synchronous communications system of claim 12 wherein the communications control module provides a single point of entry for all
hospitality applications and wherein the single point of entry
allows the synchronization of at least one wireless handheld
computing device and at least one Web page with the central
database so that at least one handheld device, at least one
Web page and central database are consistent.
14. The information management and synchronous communications system of claim 13 wherein information entered
on at least one Web page and transmitted over the internet is
automatically communicated to the central database and at
least one wireless handheld computing device.
15. The information management and synchronous communications system of claim 13 wherein information entered
on at least one wireless handheld computing device is
automatically communicated to the central database and at
least one Web page.
16. The information management and synchronous communications system of claim 12 wherein the applications
and data are synchronized by digital data transmission
between the central database, at least one wireless handheld
computing device, at least one Web server and at least one
Web page.
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